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Overview 

This tutorial is optimized for Echoview 15 and provides an introduction to fish tracking with Echoview.  

This tutorial is not intended as a comprehensive user manual.  

Further information on Echoview tools and topics can be found in the latest version of the Echoview help file. 
This can be viewed online and is installed with Echoview. Press F1 when using Echoview to open the help file 
and read context-sensitive information.  

Throughout this tutorial further reading is referred to the Echoview help file or other Echoview learning 
materials: https://www.echoview.com/support 

Prerequisites 

This tutorial assumes you have Echoview installed, and the following skills and knowledge: 

• Familiarity with the basic operation of Echoview. We strongly recommend that you complete the "Getting 
Started with Echoview" tutorial before beginning this tutorial.  

• Familiarity with a supported Microsoft Windows™ operating system. For more information refer to the 
Echoview Help file page: Computer requirements.  

• A basic understanding of echosounding techniques and hydroacoustic surveying. For more information, 
see texts such as Fisheries Acoustics (Simmonds and MacLennan, 2005, Blackwell Science, Oxford.). 

• Microsoft Excel or a similar viewer for spreadsheets. 

 

Echoview modules  

This tutorial requires a license with the Essentials and Fish Tracking modules. If you do not yet have access to 
an Echoview license with these modules, please contact info@echoview.com to request an evaluation license. 
Solution files are also included in the tutorial package to allow you to see the results of module-protected 
capabilities. Within the solution EV file, Marker regions indicate tutorial selection areas. 

Contacting Echoview  

For assistance with this tutorial please contact support@echoview.com. 

Set up 

We recommend extracting or copying the tutorial files to C:\Echoview Software\Tutorials\. If the files 

are not in this folder, use Windows Explorer to search for them. If they are not loaded on your machine, 
download and reinstall the tutorial from www.echoview.com or from the Echoview USB drive. 

Troubleshooting 

If you receive a message saying that the version of Echoview you are running cannot read the file you have 
opened, you may be running an old version of Echoview. You can download the latest version of Echoview 
from www.echoview.com.  

https://www.echoview.com/support
mailto:info@echoview.com
mailto:support@echoview.com
http://www.echoview.com/
http://www.echoview.com/
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Topic 1: Overview of Fish Tracking  

 

About fish tracking 

Fish tracking aims to identify groups of single targets that show a pattern of systematic movement, indicating 
the track followed through the water by a single fish. A fish track, therefore, is a group of closely associated 
single targets (echoes) assumed to have been generated by one fish. Single target data may be recorded to 
file. Alternatively, single targets may be detected in single beam, split beam or dual beam data.  

Fish tracks are detected in Echoview using a choice of alpha-beta tracking algorithms: 

• The 2D algorithm uses the range and time information of the single targets. 

• The 4D algorithm is intended for use with split beam data and uses the angular position information of 
the targets in the beam in addition to the range and time. 

When fish tracks are detected, Echoview draws fish track regions around associated single targets. A count of 
fish track regions is effectively a count of individual fish. 

Once fish tracks have been detected, they can be edited, viewed in 2D and 3D graphs, viewed in scenes, 
analyzed, and analysis results can be exported. 

Single target echograms 

Fish tracks can only be detected on echograms of single target variables. Single target variables may be 
logged directly by some echosounders, or can be created as virtual variables in Echoview using data from 
single beam, split beam, dual beam and wideband echosounders.  

Targets and fish tracks can also be analyzed in data from multibeam echosounders, and this is dealt with in a 
separate tutorial called Introduction to Multibeam Target Data Processing. 

You will now open an EV file that contains a single target variable. 

1. Start Echoview and close any EV files that may have opened automatically. 

2. Open the FishTracking_AllTopics.EV file. Echoview displays three echograms with the single target 

detection echogram as the active echogram. The TS and angular position echograms are operands for the 
single target detection – split beam virtual variable. You can re-dock windows to match the workspace in 
Figure 1. 

 

 

 

Figure 1. Echoview after opening the FishTracking_AllTopics.EV file. 



 

Echoview Tutorial: Introduction to Fish Tracking Page 5 of 18 

 

Topic 2: Detecting Fish Tracks 

In this topic you will learn how to detect fish tracks in Echoview.  

Detecting fish tracks in a selection 

You will now complete an exercise in which you detect fish tracks in a selection. You will complete the 
exercise in the following stages: 

• initiating fish track detection 

• assigning a "class" to the fish track regions that will be created, and 

• tuning the fish track detection algorithm and setting fish track detection parameters. 

Note:  Detecting fish tracks for an entire echogram is very similar and is covered in the help file. 

Initiating fish track detection 

In this part of the exercise you will initiate the fish track detection process. 

1. On the single target detection echogram, make a selection that is similar to the one shown in Figure 2. We 
suggest you make a selection between 5 to 19 meters depth and 1999-12-21 20:11:45 to 1999-12-21 
20:12:20 approximately. 

Making selections and other basic navigation tasks are covered in the "Getting Started" tutorial. 

 

Figure 2. A selection around multiple single targets on a single target echogram. 

2. With your mouse on the echogram, access the Shortcut (right-click) menu, click Detect Fish Tracks. The 
Detect Fish Tracks (selection) dialog box is displayed (Figure 3). 

 

Figure 3. The Detect Fish Tracks (selection) dialog box. 
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Assigning a region class to the fish tracks 

You can assign a region class to fish tracks so they can be differentiated from other fish tracks and other 
region types, e.g. you could assign classes based on the settings used to detect the fish tracks, the assumed 
species of the fish, or any other criterion. 

3. Click on the Assign class list. No classes (other than the built-in Unclassified regions) have been defined. 
You will define a class in the next steps. 

4. Click Edit. The Classes page of the EV File Properties dialog box is displayed (Figure 4). 

   

Figure 4. The Classes page of the EV File Properties dialog box. 

5. In the Region Classes section, click New. The Region Class Properties dialog box is displayed (Figure 5). 

  

Figure 5. The Regions Class Properties dialog box. 
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6. In the Name box, type: Initial detection. A region class symbol type, size and color may also be specified 
on the Display tab in this dialog. Click the Help button to read the Help page of the Region Class 
Properties dialog box, or press F1. 

7. Click OK. Initial detection is now added to the Region classes list of the Classes page of the EV File 
Properties dialog box. 

8. Repeat steps 5, 6,7 for the region class name Manual fish track. 

9. Click OK. The Detect Fish Tracks dialog box (Figure 3) is active. 

10. In the Assign class box, select Initial detection. 

Choosing a detection algorithm and setting detection parameters 

You control fish track detection in Echoview by tuning the fish track detection algorithm and setting fish track 
detection parameters. 

11. On the Detect Fish Tracks dialog box, click Properties. The Track Detection Properties dialog box from 
the Fish Tracks page of the EV File Properties dialog box is displayed. Click the Help button to read the 
Help page of the Track Detection Properties dialog box, or press F1. 

12. Click the Algorithms tab. 

 

Figure 6. Algorithm page of the Track Detection Properties dialog box. 

13. Choose the 4D (range, angles and time) option which makes use of the single target detection - split beam 
data. For this exercise, you do not need to change any of the other settings and will use the default 
algorithm settings. 

14. Click the Weights page and take a moment to review the Weights settings. Click on the Help button to 
learn about the Weights settings, or press F1. 

15. Click the Track acceptance page and take a moment to review the Track acceptance settings. Click on 
the Help button to learn about the Track acceptance settings, or press F1. 

16. Click OK on the Track Detection Properties dialog box to return to the Detect Fish Tracks (selection) 
dialog box (Figure 3). 

17. Click Detect. 

The detected fish tracks are displayed on the echogram as small colored regions and are labeled with the 
selected region class, i.e. Initial detection. Each fish track is displayed in one of eight different colors only to 
help distinguish them. You can turn off the display of region class labels in EV File Properties on the 
Echogram page. 
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Figure 7. Echogram with fish tracks. 
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Topic 3: Editing Fish Tracks 

In many circumstances, automated tracking algorithms may not include all single targets that belong to a track, 
or may falsely join tracks from different fish (this is most likely to occur when fish are dense in the water or the 
signal-to-noise ratio is low).  

Echoview provides extensive tools for manually editing fish tracks and allows you to: 

• manually create new fish tracks 

• delete fish tracks 

• add or remove targets from existing fish tracks 

• merge fish tracks 

• split fish tracks. 

 

Adding targets to a fish track 

In this exercise, you will add single targets to an existing fish track. 

18. Using the Rectangle tool, select all the fish tracks you created at the end of Choosing a detection 
algorithm and setting detection parameters in the previous exercise. 

19. Zoom in on the selection. Click on a fish track to select it. The region border around the fish track thickens 
and animates. 

20. Make a selection around some single targets that are near the selected fish track. The single targets can 
be at any depth. A valid fish track region must contain no more than one single target per ping. 

Figure 8. A selected fish track region and a selection around additional single targets. 

21. On the Shortcut (right-click) menu, click Add Targets To Fish Track. The selected single targets are 
added to the fish track. 

 

 

Figure 9. The fish track region after additional single targets are added. 

For instructions on how to remove targets from a fish track, refer to the Editing fish tracks Help page. Table of 
Contents:  How to, Detect and work with fish tracks, Editing fish tracks. 

Merging fish tracks  
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In this exercise you will merge two existing fish tracks. 

22. Make a selection that includes at least two fish tracks. Do not select fish tracks that include single targets 
on the same ping (i.e. targets that are in the same vertical column on the screen). 

 

Figure 10. A selection around multiple fish tracks. 

23. On the Shortcut (right-click) menu, click Merge Fish Tracks (or Shift+M). The selected fish tracks are 
merged to create a single fish track. 

 

Figure 11. A merged fish track. 

Splitting fish tracks 

In this exercise you will split an existing fish track into multiple fish tracks. 

24. Click on the fish track you merged in the previous exercise. The region border around the fish track 
thickens and becomes animated. 

25. Move the mouse pointer over the point where you want to split the fish track. Targets to the left of the 
selected point you select will make one fish track, targets to the right of the selected point will make 
another. 

26. On the Shortcut (right-click) menu, click Split Fish Track. The fish track is split into two fish tracks. 

Creating a fish track 

Topic 2: Detecting Fish Tracks you used a built-in algorithm in Echoview to identify fish tracks. In this exercise 
you will manually create a fish track from a selection of single targets. 

27. Click on the echogram away from any tracks to de-select the fish track. 

28. Make a selection that includes one or more single targets. 
 

 

Figure 12. A selection around multiple single targets. 
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29. On the Shortcut (right-click) menu, click Create Fish Track From Targets. 

 

Figure 13. The single target echogram showing the newly created fish track. 

 

30. Find the Region Browser. This can usually be found at the bottom of the Echoview window. You can 
change the name, class and type of an existing fish track here, and you can also add notes. On the 
Region browser for the fish track you created, assign Class to Manual fish track. 

 

   

Figure 14 Region Browser item for the manually created fish track. 
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Topic 4: Examining Fish Tracks 

In this topic you will learn about viewing fish tracks in Echoview. 

In addition to displaying fish tracks on an echogram, Echoview provides the following ways to explore fish 
tracks: 

Display option Description 

TS frequency distribution graph A bar chart that displays the percentage of targets in a fish 
track region or selection that fall within defined target 
strength range bins 

TS vs depth graph A scatter plot of the target strength against depth for 
targets in a fish track region or selection 

Angles graph A scatter plot of the minor-axis angle vs. the major-axis 
angle for each single target in a fish track region or 
selection 

2D projections graphs Four plots of the angle, range and time of the single 
targets in a fish track or a selection – useful for examining 
key features of a fish track quickly 

3D graph 3D plot of the single targets in a single fish track or in a 
selection.  

Note: 3D graphs are useful for verifying fish tracks, 
especially when they are close together, cross one 
another, or are taken from data collected with fixed 
transducer installations. 

3D fish track 3D object created from the single targets of a fish track. 
3D fish tracks can be used within scenes 

3D single target 3D objects created from the single targets in a selection or 
an entire echogram. 3D single targets can also be used 
within scenes 

Examining fish tracks 

You will now complete three exercises that demonstrate how to examine fish tracks using 2D projections, the 
3D Single Targets graph and 3D fish tracks within a scene. 

Viewing 2D projections of fish tracks 

In this exercise you will view 2D projections of the single targets in a selection of fish tracks. 

1. Complete the steps in Topic 2: Detecting Fish Tracks 

2. Make a selection in the single target detection -split beam data echogram that includes two fish tracks. 

3. On the Shortcut (right-click) menu, point to Graph Selection, and then click 2D Projections. The 2D 
Projections graphs are displayed. 
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Figure 15. Selection for two fish tracks and the Single Targets 2D Projections graphs. 

4. Click a graph and press F1 to launch the Help page that describes the graphs. 

5. Make another fish track selection either by clicking a fish track or making a new rectangular selection. The 
Linked 2D Projections graphs are updated for the new selection. 

6. Close the 2D projections graphs. 

Viewing fish tracks in the 3D Single Targets graph 

In this exercise you will view a fish track in the 3D single targets graph window. 

7. Click on a fish track. The region border around the fish track thickens and becomes animated. 

8. On the Shortcut (right-click) menu, point to Graph Region, and then click 3D Single Targets. The 3D 
single targets graph is displayed. 

 

Figure 16. The 3D Single Targets graph. 

9. Click the 3D Single Targets graph and press F1 to launch the Help page that describes the 3D single 
targets graph. 

10. Click the link to the "3D Navigation" topic. This is near the bottom of the page. Read about the different 
navigation modes and practice navigating in the 3D environment. 

11. Close the 3D single targets graph. 
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Create and view 3D fish tracks in scenes  

In this exercise you will create and view 3D fish tracks in the scene window. 

12. On the Echogram menu, point to Create 3D Object, and then click Fish Tracks. A dialog is now 
displayed describing the created object. 

13. Press OK 

14. Open the Dataflow window (shortcut F7), display the Shortcut menu (right-click), point to New, and then 
click Scene. The Scene Properties dialog is now displayed. 

15. Click the Objects page 

16. Select the check box of the object named 3D Fish track group 1. 

17. Press OK. A scene object called Scene1 is now available in the Dataflow window. Double-click it to view 
the scene containing the 3D fish tracks. To learn more about the scene window, press F1 to display the 
help file. 

18. To change the sphere and arrow size of 3D fish tracks, move the mouse above a 3D fish track, display the 
Shortcut menu (right-click), and click Group Properties. The 3D Object Properties dialog box is now 
displayed. 

19. Click the Display page. 

20. In the Track point radius box, type: 0.05 

21. In the Track arrow radius box, also type: 0.05 

22. Select Alternate palette. 

23. Press OK 

24. Experiment with the scene window and the 3D fish tracks. Creating and adding 3D single targets to a 
scene is very similar. See the help file for further information on 3D fish tracks and 3D single targets. 

25. Close the help file and the scene window. 
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Topic 5: Analyzing Fish Tracks 

Echoview provides two ways of generating analyses of fish tracks. 

 

Method Description 

On-screen analysis Displays analysis results for a single fish track. Select the Linked setting (see 
bottom of Figure 17) on the Results dialog box to update results for 
subsequently selected fish tracks.  

Export analysis Exports analysis results for all fish tracks (or a selected class of fish track). 

The data are exported to comma separated value (.csv) files and can be 
opened in most spreadsheet applications. Some exports can also be 
formatted for use with database applications. 

An on-screen analysis of a fish track 

In this exercise you will generate an on-screen analysis of a fish track. 

1. Complete the steps in Topic 2: Detecting Fish Tracks 

2. On the single target echogram, click on a fish track region. The region border around the fish track 
thickens and animates. 

3. On the Shortcut (right-click) menu, click Analyze Fish Track. The Fish Track Analysis Results dialog box 
is displayed. Click on the Help button to learn about the analysis variables, or press F1. 

 

Figure 17. Fish Track Analysis Results dialog box 

4. Close the Fish Track Analysis Results dialog box. 

 

 Exporting fish track analysis results 

In this exercise you will export an analysis of fish tracks. You will complete this exercise in the following 
stages: 
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• selecting the analysis variables to export 

• selecting the fish tracks to analyze and exporting the analysis 

• viewing the exported file. 

Note: You will export fish tracks by cells in this exercise. Exporting fish tracks by regions and by region-cell 
intersections is very similar and is covered in the help file under About exporting analyses. 

Selecting the analysis variables to export 

Before you export an analysis of fish tracks, you must select the analysis variables you want to export. A list of 
the available analysis variables is provided in the help file on the About Analysis Variables page in the Single 
target and fish track analysis variables section. 

5. On the View menu in the toolbar, click EV File Properties. The EV File Properties dialog box is displayed 
(Figure 18). 

6. Click the Export page. 

   

Figure 18. Export page of the EV File Properties dialog box. 

7. Closely related export variables are grouped together in the Analysis variables to export section. Click 
the symbol next to a group title to expand the group to its individual variables. Click on the Help button to 
learn about the settings in the Export page of the EV File Properties dialog box.  

8. Expand the Single targets dropdown menu in the Analysis variables to export section. Select 
Num_targets, Target_range_max, Target_range_mean  Target_range_min , TS_max, TS_mean, and  
TS_min from the Single targets group. Note: You can also select common (i.e. non-fish tracking specific) 
analysis variables from the list and they will be included in the export file.  

9. Select the Spreadsheet format (single file) option. 

10. Click OK to save the settings. 
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Selecting the fish tracks to analyze and exporting the analysis 

You will now select which fish tracks to analyze and export the analysis results. 

11. Select the single target detection echogram. On the Echogram menu in the toolbar, point to Export, point 
to Analysis by Cells, and then click Fish Tracks. The Export Fish Tracks Regions by Cells, Select 
Classes dialog box is displayed. 

  

Figure 19. Export Fish Track Regions by cells dialog box. 

12. In the Export regions with class list, choose Initial detection. This limits the export to fish tracks of a 
single class. 

13. Click Export. The Export Fish Tracks by Cells dialog box is displayed. 

14. Save the export file using a name and folder of your choosing. 

Tips 

• A Fish track analysis exporter object on the Dataflow window, allows you to customize, remember and 
annotate an export. For further information refer to the Echoview Help page, About Exporter objects. 

• Calibration settings for analysis exports are specific to each variable, and are not included in export data. 

• Data management tips: 

To ensure that you have a permanent record of the calibration settings at the time of your export, create a 
read-only folder to store your export data. 

For each export, save a copy of the EV file to the folder path of the export. 

• You can save time by specifying a user-defined keyboard shortcut for the Create Fish Tracks from 
Targets feature, as well as many other fish track editing actions. For more information refer the User-
defined keyboard shortcuts page in the Help file. 

Viewing exported fish track analyses 

In this exercise you will open the fish track analysis export file and review its contents. 

15. Start Microsoft Excel (or another spreadsheet application that can read .csv files). 

16. Open the file you created in the spreadsheet application. 

Note: The export file contains a row for each fish track. Each row contains values that identify the fish track, 
identify the cell in which the fish track ends and provide the results for the selected analysis variables. 

For a description of each analysis variables, refer to the Echoview Help file page “About Analysis Variables”. 
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Figure 20. ExportFishTracks.csv file opened in Microsoft Excel. 

17. Close the spreadsheet application. 

You should close FishTracking_AllTopics.EV file.  If you wish to save the changes, it is recommended 

that you save the file with a different name so you can repeat this topic at a future date. 

18. On the File menu, click Save As. 

19. Select the folder in which the tutorial data have been saved.  

20. In the Filename box, enter a name for the EV file. 

21. Click Save. 

22. On the File menu, click Close. 

If you are going to complete another tutorial, or practice what you learned in this tutorial, you should leave 
Echoview running, otherwise close Echoview. 
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